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1 Introduction 

BIMXplorer is a plugin for Autodesk 

application that can import IFC-files

format). BIMXplorer makes it possible to “walk around” in a BIM similar to a 3D game, either in a 

regular desktop mode or using the Oculus Rift 

Figure 1: BIMXplorer interface. 

The first part of this guide will explain how to install and use the BIMXplorer Revit addin and 

the standalone viewer WITHOUT Oculus Rift

use BIMXplorer together with Oculus

2 Setup 

Unzip the downloaded file into a temp dir. 

This will install both the Revit 

FYI the software will install into “C:

the addin will be added to “C

“...\2018”.  

BIMXplorer is targeting OpenGL 4.5

(however, the fallback version

quality). In case of any problems, make sure that the latest graphics drivers are installed.

On computers with NVIDIA cards, 

Panel. Go to Manage 3D settings

Threaded optimization ON, 

performance". 

On computers with integrated AND NVIDIA graphics card, make sure NVIDIA processor is 

chosen as “Preferred graphics processor”.
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Autodesk Revit (2016, 2017 and 2018) as well as a standalone viewer 

files or load previously saved .grx-files (BIMXplorer’s 

makes it possible to “walk around” in a BIM similar to a 3D game, either in a 

regular desktop mode or using the Oculus Rift or HTC Vive HMD. 

part of this guide will explain how to install and use the BIMXplorer Revit addin and 

the standalone viewer WITHOUT Oculus Rift or HTC Vive. The last part will explain how to 

use BIMXplorer together with Oculus Rift and HTC Vive. 

d file into a temp dir. Make sure Revit is not running.

vit addin as well as the standalone viewer.  

will install into “C:\ProgramData\VIZCODE\BIMXplorer v

will be added to “C:\ProgramData\Autodesk\Revit\Addins\201

OpenGL 4.5 but has a fallback for OpenGL 4.3 

versions has no Oculus or Vive support and has limited graphics 

case of any problems, make sure that the latest graphics drivers are installed.

cards, right click on the desktop and launch the 

Manage 3D settings. Make sure Vertical sync is Application Controlled

, and set "Power management mode" to "Prefer maximum 

On computers with integrated AND NVIDIA graphics card, make sure NVIDIA processor is 

chosen as “Preferred graphics processor”. 
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well as a standalone viewer 

files (BIMXplorer’s proprietary file 

makes it possible to “walk around” in a BIM similar to a 3D game, either in a 

 

part of this guide will explain how to install and use the BIMXplorer Revit addin and 

part will explain how to 

Make sure Revit is not running. Run setup.exe. 

BIMXplorer v1.4.5” and 

2016”, “...\2017”, and 

OpenGL 4.3 and OpenGL 2.1 

has no Oculus or Vive support and has limited graphics 

case of any problems, make sure that the latest graphics drivers are installed. 

right click on the desktop and launch the NVIDIA Control 

Vertical sync is Application Controlled, turn 

"Power management mode" to "Prefer maximum 

On computers with integrated AND NVIDIA graphics card, make sure NVIDIA processor is 



3 Trial period and activation

When BIMXplorer is installed for the first time on a computer 

period. Every time you start BIMXplorer it will display the 

either with a unique Activation Code

Floating license). Go to www.bimxplorer.com

information on how to purchase 

has ended you can start BIMXplorer in Trial Mode by clicking “Trial Run”. 

Figure 2: For a floating license, select 

select “Node-Locked License” and click 

receiving the “Activation Code”, enter it and click 

4 Use BIMXplorer with Revit

Note: BIMXplorer is not yet “signed” with Autodesk Revit 2017

2017 (or 2018) for the first time after you install BIMXplorer you

dialog similar to the following (but with different version nu

 

Figure 3: The “Unsigned Add-In” Dialog in Revit 2017

 

Just click “Always Load”. 
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Trial period and activation 

MXplorer is installed for the first time on a computer it will begin a 

period. Every time you start BIMXplorer it will display the License Dialog until you activate it

a unique Activation Code (for Node-Locked license) or user/pas

www.bimxplorer.com or contact license@bimxplorer.com

information on how to purchase a Node-Locked or Floating license. Unless the

has ended you can start BIMXplorer in Trial Mode by clicking “Trial Run”.  

For a floating license, select “Floating license” and enter user/password. For a Node

and click “Activate...”. This will display the Identification and Request Code. Upon 

, enter it and click “Activate”. 

with Revit 

Note: BIMXplorer is not yet “signed” with Autodesk Revit 2017 or 2018. When starting Revit 

for the first time after you install BIMXplorer you will be prompted with a 

dialog similar to the following (but with different version number): 

 

In” Dialog in Revit 2017 (similar in Revit 2018). 
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it will begin a 30-day trial 

Dialog until you activate it, 

Locked license) or user/password (for 

license@bimxplorer.com to get 

Unless the Trial Period 

 

 
and enter user/password. For a Node-Locked license, 

This will display the Identification and Request Code. Upon 

When starting Revit 

will be prompted with a 

 



After install, start Revit (2016

the “basic” or the “advanced” Revit sample project for the first time in order to just give it a 

slow start). Go to the default 3D

External Tools->BIMXplorer v1.

A new window will open and the 

the geometry that is currently visible so you can isolate or hide 

certain parts to be shown in the viewer). 

Sometimes the Revit window will put its

minimize it, or select the plugin window (BIMXplorer) from the 

After the model has been loaded (progress bar done) 

be placed so that you see the model. Pres

that all of model is visible (i.e. z

the camera in the middle of the model

5 A little bit on navigation

Right Mouse Click: Activate/Deactivate MouseLook

Move Mouse: Look around (when MouseLook is ACTIVE)

w,a,s,d : w=Forward, a=Left, s

q,e: Move camera up/down (when collision detection is NOT active, se

Shift + w,a,s,d : Move faster 

Left Mouse Click: Select object (when 

Esc: Un-select any selected object

h: Hide selected object 

u: Unhide all (show all) 

F8: Toggle fullscreen 

Space: Place camera so that all of model is visible (Zoom all)

Shift + Space: Place camera in center of model

F4: Toggle Rendering statistics (frame time)

If there are cameras defined in the Revit model, these will now be located at the buttons [1

9] (i.e. press 1 to get to the location defined by the “first” camera). If you hold down [shift] 

while pressing the camera number you will “animate” from you current position to the 

chosen camera position. 

v: Add current viewpoint (accessible from the button [1

In the Camera Settings Dialog

speed multiplier (how much faster it goes when shift is pressed) as well as 

(when collision detection is active).
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(2016, 2017 or 2018) and load or create a model (perhaps use either 

the “basic” or the “advanced” Revit sample project for the first time in order to just give it a 

default 3D-view and under the Add-Ins tab choose: 

>BIMXplorer v1.4.5. 

ndow will open and the addin will extract the model from Revit (the 

the geometry that is currently visible so you can isolate or hide objects

certain parts to be shown in the viewer).  

Sometimes the Revit window will put itself *above* the plugin window so you have to 

minimize it, or select the plugin window (BIMXplorer) from the Windows taskbar.

After the model has been loaded (progress bar done) the default camera position might not 

be placed so that you see the model. Press the [spacebar] in order to place the camera so 

i.e. zoom all). Hold [Shift] and press [spacebar

the camera in the middle of the model 

A little bit on navigation and interaction 

e/Deactivate MouseLook 

: Look around (when MouseLook is ACTIVE) 

s=Back, d=Right (When MouseLook is ACTIVE

: Move camera up/down (when collision detection is NOT active, see below)

 

Select object (when MouseLook is NOT active) 

select any selected object 

: Place camera so that all of model is visible (Zoom all) 

a in center of model 

: Toggle Rendering statistics (frame time) 

If there are cameras defined in the Revit model, these will now be located at the buttons [1

9] (i.e. press 1 to get to the location defined by the “first” camera). If you hold down [shift] 

while pressing the camera number you will “animate” from you current position to the 

: Add current viewpoint (accessible from the button [1-9]) 

Camera Settings Dialog (Settings->Camera Settings…) it is possible to change 

(how much faster it goes when shift is pressed) as well as 

(when collision detection is active). 
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create a model (perhaps use either 

the “basic” or the “advanced” Revit sample project for the first time in order to just give it a 

  

will extract the model from Revit (the addin extracts 

objects if you only want 

elf *above* the plugin window so you have to 

taskbar. 

the default camera position might not 

place the camera so 

spacebar] in order to place 

ACTIVE)  

below) 

If there are cameras defined in the Revit model, these will now be located at the buttons [1-

9] (i.e. press 1 to get to the location defined by the “first” camera). If you hold down [shift] 

while pressing the camera number you will “animate” from you current position to the 

>Camera Settings…) it is possible to change speed, 

(how much faster it goes when shift is pressed) as well as “eye height” 



6 Save/Open File 

When the model has been loaded in 

save a binary file (*.grx) that can be opened in the stand

Revit installed, you can start the stand

desktop) and then choose File

7 Collision detection 

There is no collision by default. However, once a model is loaded you can choose 

>Generate Collision Meshes 

When these meshes are generated, 

collision. You can then only “enter” through doors. Also, you need to have something under 

"your feet" or you will just fall down. Press "

gravity.  

It’s also possible to only generat

Topography. For large and complex models this is usually

to generate. 

At the Collision menu it is also possible to clear all collision meshes in the scene or

Add/Remove collision mesh for the selected object

The time taken to calculate collision meshes will vary depending on model complexity. For 

instance, the “Revit basic sample” project as well as the “advanced sample” 

around 5 seconds (using the “Everything” alternative)

there are basically two types of collision meshes 

The triangular meshes are used for

topography and stairs. However, f

generated (this is a much more efficient representation in terms of creation and real

performance). This works well in most of the cases, but for furniture objects that

non-convex the “collision volume” becomes very different from the actual geometry

no collision mesh is currently generated for railing objects

If collision meshes are generated before the file is saved

saved (one .cma and one .cms file with the same name as the *.grx file) that contains the 

collision meshes. When you later open the *.grx file (in standalone mode) the collision 

meshes are imported as well (unless you choose to delete the files) so you 

new “collision mesh generation step”, just press “

8 Materials, shadows

There is (basic) support for most of the Revit materials (i.e. color or diffuse texture

color, as well as transparency and simple cu

is fairly simple, but can be enhanced with 

You can enable/disable shadows

If your model has linked files you can control the visibility of thes

Visibility. Check or uncheck to hide/show links.
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When the model has been loaded in BIMXplorer you can choose File->Save File

that can be opened in the standalone viewer. That is, without having 

talled, you can start the standalone BIMXplorer (should be a shortcut on the 

File->Open File in order to load a previously saved file (*.grx).

 

There is no collision by default. However, once a model is loaded you can choose 

 (Everything) in order to activate the collision functionality. 

When these meshes are generated, you can press “c” and then you will have gravity and 

. You can then only “enter” through doors. Also, you need to have something under 

"your feet" or you will just fall down. Press "c" again if you want to disable collision and 

generate collision meshes for Floors and Stairs or 

. For large and complex models this is usually preferred because it is 

At the Collision menu it is also possible to clear all collision meshes in the scene or

Add/Remove collision mesh for the selected object. 

The time taken to calculate collision meshes will vary depending on model complexity. For 

the “Revit basic sample” project as well as the “advanced sample” 

ing the “Everything” alternative). Also, regarding collision detection 

there are basically two types of collision meshes – triangular meshes and convex meshes. 

The triangular meshes are used for the majority of objects, such as 

However, for objects of the type “Furniture” a convex mesh will be 

generated (this is a much more efficient representation in terms of creation and real

This works well in most of the cases, but for furniture objects that

the “collision volume” becomes very different from the actual geometry

no collision mesh is currently generated for railing objects. 

If collision meshes are generated before the file is saved (*.grx), two additional files are al

saved (one .cma and one .cms file with the same name as the *.grx file) that contains the 

collision meshes. When you later open the *.grx file (in standalone mode) the collision 

meshes are imported as well (unless you choose to delete the files) so you 

new “collision mesh generation step”, just press “c” to activate it. 

, shadows and links 

here is (basic) support for most of the Revit materials (i.e. color or diffuse texture

as well as transparency and simple cubemap reflections). The lighting used

fairly simple, but can be enhanced with Sun Shadows (see Figure 4).  

shadows under Settings->Shadow Settings... 

If your model has linked files you can control the visibility of these with 

to hide/show links. 
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>Save File in order to 

alone viewer. That is, without having 

alone BIMXplorer (should be a shortcut on the 

in order to load a previously saved file (*.grx). 

There is no collision by default. However, once a model is loaded you can choose Collision-

in order to activate the collision functionality. 

n you will have gravity and 

. You can then only “enter” through doors. Also, you need to have something under 

" again if you want to disable collision and 

or Floors, Stairs and 

preferred because it is much faster 

At the Collision menu it is also possible to clear all collision meshes in the scene or 

The time taken to calculate collision meshes will vary depending on model complexity. For 

the “Revit basic sample” project as well as the “advanced sample” project will take 

Also, regarding collision detection 

triangular meshes and convex meshes. 

 walls, slabs, roofs, 

a convex mesh will be 

generated (this is a much more efficient representation in terms of creation and real-time 

This works well in most of the cases, but for furniture objects that are very 

the “collision volume” becomes very different from the actual geometry. Also, 

(*.grx), two additional files are also 

saved (one .cma and one .cms file with the same name as the *.grx file) that contains the 

collision meshes. When you later open the *.grx file (in standalone mode) the collision 

meshes are imported as well (unless you choose to delete the files) so you don’t have to do a 

here is (basic) support for most of the Revit materials (i.e. color or diffuse texture, tint 

bemap reflections). The lighting used by default 

e with Visibility->Links 



Figure 

 

9 Use the “Standalone viewer”

Start BIMXplorer v1.4.5 (either from the 

Choose File->Open File to load a previously saved .grx

IFC 2x3 file. It is also possible to import 

interaction is the same as for the Revit plugin (see above)

also choose (Import And) Append

Append will add the model to the current scene

current scene and also make it possible to hide/show sub

Visibility...  

VIZCODE DEVELOPMENT AB

Figure 4: Shadows off (top) as well as on (bottom). 

alone viewer” 

(either from the Start menu or from the shortcut on the desktop). 

to load a previously saved .grx-file or File->Import IFC

It is also possible to import 3ds files exported from SketchUp. 

is the same as for the Revit plugin (see above). For .grx files and IFC

Append (IFC) or (Import And) Append (IFC) as Link

will add the model to the current scene; Append as Link will add the model to the 

current scene and also make it possible to hide/show sub-models under
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tart menu or from the shortcut on the desktop). 

Import IFC to import an 

files exported from SketchUp. Navigation and 

nd IFC-files you can 

as Link.  

will add the model to the 

models under Visibility->Links 



In summary, Import And Append IFC as Link

IFC-files, each one representing a different discipline (i.e. Architectural, Structural, HVAC, 

etc.). The visibility of each discipl

Visbility...) 

9.1 IFC Import options 

Upon selecting an IFC-file (using any of the Import IFC alternatives)

show: 

For normal IFC-files, choose In

large IFC-files exceeding the computer’s internal memory. 

Property Sets for all objects in the scene, 

it might lead to a slower import proc

10 Color-coding different links

If you have links in the Revit file or if you import several IFC

Append IFC As Link you can override the default color 

Visibility->Links Visibility... and select any link and right

select a color for all the objects in that link. This is useful during design review session to 

separate objects by discipline.

Figure 5: Overriding the object color in links
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Import And Append IFC as Link will make it possible to load several different 

files, each one representing a different discipline (i.e. Architectural, Structural, HVAC, 

. The visibility of each discipline can then be controlled individually (

 

(using any of the Import IFC alternatives), the following dialog will 

 

choose In-memory. The Database alternative is mainly if we have very 

files exceeding the computer’s internal memory. If you also want to extract the 

Property Sets for all objects in the scene, check “Import Property Sets”. It is optional because 

it might lead to a slower import process. 

coding different links 

If you have links in the Revit file or if you import several IFC-files using 

you can override the default color of the objects in a certain link. Go to 

nd select any link and right-click and chose Override Color...

select a color for all the objects in that link. This is useful during design review session to 

separate objects by discipline. 

 
Overriding the object color in links. 
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will make it possible to load several different 

files, each one representing a different discipline (i.e. Architectural, Structural, HVAC, 

ine can then be controlled individually (Visibility->Links 

, the following dialog will 

ative is mainly if we have very 

If you also want to extract the 

It is optional because 

files using File->Import and 

the objects in a certain link. Go to 

Override Color... to 

select a color for all the objects in that link. This is useful during design review session to 



11 Fixing “broken” IFC 

In some cases the IFC-geometry can have “flipped faces” as illustrated in Figure 

Figure 6: IFC object with “broken” geometry

 

To fix this, select the object and choose 

IFC geometry). The result is shown in Figure 7.

Figure 7: IFC object after correcting the geometry

 

For files with many “broken” objects you can choose

(for IFC geometry) in order to process all objects in the file.
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IFC geometry 

geometry can have “flipped faces” as illustrated in Figure 

 
IFC object with “broken” geometry. 

To fix this, select the object and choose Geometry->Fix Normals On Selected Objects (for 

. The result is shown in Figure 7. 

 
IFC object after correcting the geometry. 

with many “broken” objects you can choose Geometry->Fix Normals On 

in order to process all objects in the file. 
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geometry can have “flipped faces” as illustrated in Figure 6. 

>Fix Normals On Selected Objects (for 

>Fix Normals On All Objects 



12 Display object properties

Information->Selection Info will display the 

its properties in the dialog, as shown in Figure 8.

Figure 8: Displaying object properties (Property Sets)
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object properties 

will display the Properties Dialog. Selecting an object will show 

its properties in the dialog, as shown in Figure 8. 

 
Displaying object properties (Property Sets). 

 

CODE DEVELOPMENT AB 

. Selecting an object will show 



13 Using BIMXplorer with a VR headse

BIMXplorer has support for both Oculus Rift and HTC Vive. However, before using 

BIMXplorer with either one 

properly (i.e. install the Oculus Software or Steam VR and also follow the setup guides 

regarding tracker positioning, 

As soon as a headset is correctly setup and 

mode (even from within Revit).

13.1 Using BIMXplorer with HTC Vive

If the Vive is connected when BIMXplorer is started (either as standalone or as a Revit 

plugin) it will automatically enter “VR mode”. The menu system (i.e. file loading 

is functional as before but the navigation interface is different. Se

interaction interface: 

Figure 9: General interaction interface with the Vive controllers
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Using BIMXplorer with a VR headset 

BIMXplorer has support for both Oculus Rift and HTC Vive. However, before using 

BIMXplorer with either one of these systems you will first need to setup each system 

properly (i.e. install the Oculus Software or Steam VR and also follow the setup guides 

, calibration, room setup, etc.). 

As soon as a headset is correctly setup and connected, BIMXplorer will always start in VR

mode (even from within Revit). 

Using BIMXplorer with HTC Vive 

If the Vive is connected when BIMXplorer is started (either as standalone or as a Revit 

plugin) it will automatically enter “VR mode”. The menu system (i.e. file loading 

is functional as before but the navigation interface is different. See figure below for general 

General interaction interface with the Vive controllers. 
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BIMXplorer has support for both Oculus Rift and HTC Vive. However, before using 

you will first need to setup each system 

properly (i.e. install the Oculus Software or Steam VR and also follow the setup guides 

, BIMXplorer will always start in VR-

If the Vive is connected when BIMXplorer is started (either as standalone or as a Revit 

plugin) it will automatically enter “VR mode”. The menu system (i.e. file loading and settings) 

figure below for general 

 
 



13.1.1 SteamVR Settings 

Make sure “Allow asynchronous reprojection

checked. Also, use “Manual Override

Figure 

13.1.2 Navigation – Fly Mode

This is the default navigation mode when you enter VR

”touchpad” on any of the two controllers 

and ”Down” backward. Pressing ”Up” on 

faster. Same for ”Down”. If you have collision meshes generated, you can press ”

keyboard to activate gravity and collision detection. It is also possible to navigate using 

”Teleport mode” (see 13.2.4).

13.1.3 Tools Palette 

Assuming the left controller was the first one you ”activated”, this will be you

MenuController. The right one will be your 

With no tool active when you start (you’re in navigation mode when you start), 

trigger on the right controller will display a ”ray

instance, you can use this ray

model on the computer screen.

When pressing the trigger on the left controller a ”tools

from the right controller, you can now select a tool or navigation mode. 

click, your ”click” in VR will happen when you RELEASE the trigger.

VIZCODE DEVELOPMENT AB

llow asynchronous reprojection” and “Allow interleaved reprojection

Manual Override” in Video/Supersampling settings and set to 100%.

Figure 10: SteamVR settings for BIMXplorer. 

Fly Mode 

This is the default navigation mode when you enter VR-mode. Pressing 

of the two controllers will take you forward in the direction you look

Pressing ”Up” on both controllers at the same time will make you go 

faster. Same for ”Down”. If you have collision meshes generated, you can press ”

ard to activate gravity and collision detection. It is also possible to navigate using 

). 

Assuming the left controller was the first one you ”activated”, this will be you

. The right one will be your ToolsController.  

With no tool active when you start (you’re in navigation mode when you start), 

trigger on the right controller will display a ”ray-pointer”. During design review sessions, for 

instance, you can use this ray-pointer to guide other people that are looking at the same 

model on the computer screen. 

When pressing the trigger on the left controller a ”tools-palette” will show up. Using the ray 

from the right controller, you can now select a tool or navigation mode. Similar to a mous

in VR will happen when you RELEASE the trigger. 
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llow interleaved reprojection” is 

Supersampling settings and set to 100%. 

 

Pressing ”Up” on the 

in the direction you look, 

controllers at the same time will make you go 

faster. Same for ”Down”. If you have collision meshes generated, you can press ”c” on the 

ard to activate gravity and collision detection. It is also possible to navigate using 

Assuming the left controller was the first one you ”activated”, this will be your 

With no tool active when you start (you’re in navigation mode when you start), pressing the 

. During design review sessions, for 

ther people that are looking at the same 

palette” will show up. Using the ray 

Similar to a mouse-



Figure 11: Press left trigger to show the Tools Palette

mode. 

13.1.4 Navigation – Teleport Mode

 

Figure 12: Activate teleport mode. 

To activate Teleport Mode:

Press and hold the trigger on the "left" controller to show the 

Tools Palette. Press and hold the trigger on the "right" controller 

and point at the "tel

controller to activate.
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Press left trigger to show the Tools Palette. Press/release right trigger to select tool or navigation 

Teleport Mode 

 

To activate Teleport Mode: 

Press and hold the trigger on the "left" controller to show the 

Tools Palette. Press and hold the trigger on the "right" controller 

and point at the "teleport" icon. Release the trigger on the "right" 

controller to activate. 
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Press/release right trigger to select tool or navigation 

 

Press and hold the trigger on the "left" controller to show the 

Tools Palette. Press and hold the trigger on the "right" controller 

eport" icon. Release the trigger on the "right" 



Figure 13: Use teleport mode. 

 

 

13.1.5 Labels in VR - General

BIMXplorer v1.4.5 introduces the concept of 3D labels, where you can take measurements 

and extract properties and define an “information view” directly in VR (Figure 

Figure 14: 3D labels containing object properties

When in "Teleport mode":

Press and hold anywhere on the touchpad

order to show the "teleport gizmo". Release the button to 

"teleport" to the location you point a
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General 

er v1.4.5 introduces the concept of 3D labels, where you can take measurements 

and extract properties and define an “information view” directly in VR (Figure 

object properties and measurements created and arranged direc

When in "Teleport mode": 

Press and hold anywhere on the touchpad (big round button) in 

order to show the "teleport gizmo". Release the button to 

"teleport" to the location you point at. 
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er v1.4.5 introduces the concept of 3D labels, where you can take measurements 

and extract properties and define an “information view” directly in VR (Figure 14). 

 
created and arranged directly in VR-mode.  



13.1.6 Measure distance 

 

With this tool active you will get a new panel on the right controller displaying your currently 

measured distance. Press/release the trigger on the right controller to select two points in 

the scene. A dark yellow “dist

the distance. Select two other points in order to make a new measurement (the previous 

one will then disappear). Press/

make the distance permanent (it will then turn red). As long as you haven’t made the 

distance permanent, you can “aim” at any of the 

When the blue dot is shown you can press/hold the trigger to grab the point. Release the 

trigger in order to place it at its new location.

Move/fold/delete “labels”: 

• As long as you have any of the tools that create labels active (distance, perpendicular 

distance, or select) you can move/fold/delete any of the labels in the scene.

• When you “aim” at the 

can press and hold the trigger to grab the label. Release the trigger again in order to 

place the “label”. 

• “Aim” at the “minus sign” and press/release the trigger in order to fold the label. Do 

the same in order to expand it. 

• “Aim” at the “cross sign” and press/release the trigger in order to delete

Figure 15: Measure distance (left), move label (middle), and make distance/label permanent (right).

When you are “in a tool” you can sti

To “exit” from a tool, select either another tool on the “Tools

“teleport” icon to enter “navigation

13.1.7 Measure perpendicular distance

 

This tool is similar as the Measur

orientation of the surface you hit (the normal of the surface), a new ray will be constructed. 
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With this tool active you will get a new panel on the right controller displaying your currently 

release the trigger on the right controller to select two points in 

the scene. A dark yellow “distance ray” will be rendered together with a “label” displaying 

Select two other points in order to make a new measurement (the previous 

Press/release the “middle” button on the touchpad in order to 

ermanent (it will then turn red). As long as you haven’t made the 

distance permanent, you can “aim” at any of the distance points and a blue dot will appear. 

When the blue dot is shown you can press/hold the trigger to grab the point. Release the 

n order to place it at its new location. 

As long as you have any of the tools that create labels active (distance, perpendicular 

distance, or select) you can move/fold/delete any of the labels in the scene.

When you “aim” at the “label”, a blue dot will display. When the dot is shown you 

can press and hold the trigger to grab the label. Release the trigger again in order to 

“Aim” at the “minus sign” and press/release the trigger in order to fold the label. Do 

e same in order to expand it.  

“Aim” at the “cross sign” and press/release the trigger in order to delete

Measure distance (left), move label (middle), and make distance/label permanent (right).

When you are “in a tool” you can still navigate forward/back with the left controller

To “exit” from a tool, select either another tool on the “Tools Palette” or the “bird”

to enter “navigation-only mode”. 

Measure perpendicular distance 

This tool is similar as the Measure Distance Tool, but you only select one point. Based on the 

orientation of the surface you hit (the normal of the surface), a new ray will be constructed. 
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With this tool active you will get a new panel on the right controller displaying your currently 

release the trigger on the right controller to select two points in 

ance ray” will be rendered together with a “label” displaying 

Select two other points in order to make a new measurement (the previous 

release the “middle” button on the touchpad in order to 

ermanent (it will then turn red). As long as you haven’t made the 

points and a blue dot will appear. 

When the blue dot is shown you can press/hold the trigger to grab the point. Release the 

As long as you have any of the tools that create labels active (distance, perpendicular 

distance, or select) you can move/fold/delete any of the labels in the scene. 

“label”, a blue dot will display. When the dot is shown you 

can press and hold the trigger to grab the label. Release the trigger again in order to 

“Aim” at the “minus sign” and press/release the trigger in order to fold the label. Do 

“Aim” at the “cross sign” and press/release the trigger in order to delete the label. 

 

Measure distance (left), move label (middle), and make distance/label permanent (right). 

ll navigate forward/back with the left controller 

alette” or the “bird” or 

e Distance Tool, but you only select one point. Based on the 

orientation of the surface you hit (the normal of the surface), a new ray will be constructed. 



This ray is perpendicular to the surface and will extend until it hits some other surface in the 

3D-model. The length of the ray will be displayed on the panel and on the label. 

Press/release the “middle” button on the touchpad to make the distance permanent (it will 

then turn purple). This tool is useful for measuring the width of corridors or a distanc

the floor to the ceiling. 

Similar as for the Measure Distance Tool, you can move/fold/delete the label.

 

13.1.8 Select and display object properties

 

With this tool you can select any object in the 3D

and display all of its “property sets”

one property sets, you can cycle through them by pressing/releasing left/right on the right 

controller. Use up/down to navigate in the list. Press/release the middle button to 

the property to the label. The text will then get a cyan color on the panel. Press/release the 

middle button again to remove the property from the label (the text on the panel will then 

turn black again). The system will remember which propertie

automatically place them on the label for the next object you select.

Similar as for the Measure Distance

move/fold/delete the label. 

Figure 16: Select an object and display its

VIZCODE DEVELOPMENT AB

This ray is perpendicular to the surface and will extend until it hits some other surface in the 

model. The length of the ray will be displayed on the panel and on the label. 

Press/release the “middle” button on the touchpad to make the distance permanent (it will 

then turn purple). This tool is useful for measuring the width of corridors or a distanc

Similar as for the Measure Distance Tool, you can move/fold/delete the label.

Select and display object properties 

With this tool you can select any object in the 3D-model by pressing/releasing the trigger 

of its “property sets” on the panel and on a label. If an object has more than 

one property sets, you can cycle through them by pressing/releasing left/right on the right 

controller. Use up/down to navigate in the list. Press/release the middle button to 

the property to the label. The text will then get a cyan color on the panel. Press/release the 

middle button again to remove the property from the label (the text on the panel will then 

turn black again). The system will remember which properties you recently selected and 

automatically place them on the label for the next object you select. 

Distance and Measure Perpendicular Distance Tool

Select an object and display its properties. 
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This ray is perpendicular to the surface and will extend until it hits some other surface in the 

model. The length of the ray will be displayed on the panel and on the label. 

Press/release the “middle” button on the touchpad to make the distance permanent (it will 

then turn purple). This tool is useful for measuring the width of corridors or a distance from 

Similar as for the Measure Distance Tool, you can move/fold/delete the label. 

by pressing/releasing the trigger 

If an object has more than 

one property sets, you can cycle through them by pressing/releasing left/right on the right 

controller. Use up/down to navigate in the list. Press/release the middle button to “transfer” 

the property to the label. The text will then get a cyan color on the panel. Press/release the 

middle button again to remove the property from the label (the text on the panel will then 

s you recently selected and 

Tools, you can 

 



13.1.9 Hide and show links/layers

 

Similar as with the Select Tool you will get a list on the right panel with all the different 

links/layers in the model. If there are more links than can fit on a single panel, you can cycle 

through them by pressing/releasing left/right on the right controller. Use up/down to 

navigate in the list. Press/release the middle button to hide or show the link (cyan text = 

visible, black text = hidden). 

Figure 17: Use up/down and left/right in order to select which link t

visibility. 

 

 

13.1.10 Section plane 

 

With this tool you can define a section plane in order to “cut through the building”

18). Selecting this tool will bring up six different settings on the panel on the right contro

Use Up/down on the right controller in order to select which setting to modify (Figure 
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Hide and show links/layers 

Similar as with the Select Tool you will get a list on the right panel with all the different 

If there are more links than can fit on a single panel, you can cycle 

g/releasing left/right on the right controller. Use up/down to 

navigate in the list. Press/release the middle button to hide or show the link (cyan text = 

Use up/down and left/right in order to select which link to hide/show. Use middle

With this tool you can define a section plane in order to “cut through the building”

Selecting this tool will bring up six different settings on the panel on the right contro

Use Up/down on the right controller in order to select which setting to modify (Figure 
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Similar as with the Select Tool you will get a list on the right panel with all the different 

If there are more links than can fit on a single panel, you can cycle 

g/releasing left/right on the right controller. Use up/down to 

navigate in the list. Press/release the middle button to hide or show the link (cyan text = 

 
o hide/show. Use middle-click to toggle 

With this tool you can define a section plane in order to “cut through the building” (Figure 

Selecting this tool will bring up six different settings on the panel on the right controller. 

Use Up/down on the right controller in order to select which setting to modify (Figure 19). 



Figure 18: Example of using a section plane in VR.

 

Figure 19: Use up/down in order to select which setting to modify.

The different settings are explained b

First line: Currently unused. 

Second line: Click left/right on the right controller to select three different modes

defining the section plane: 

• CONTROLLER: Will let you define the section plane by pressing/holding the trigger 

and moving the controller. The plane will align with the panel. Release the trigger in 

order to freeze the plane

• RAY FRONT: Define the plane by selecting a geometric face 

(press/release the right trigger)

everything on the front

• RAY BACK: Define the plane by selecting a geometric face in the model (press/release 

the right trigger). The plane will align with the selected geometry, and everything on 

the back-side of the face will be cut away.
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Example of using a section plane in VR. 

Use up/down in order to select which setting to modify.

The different settings are explained below: 

Click left/right on the right controller to select three different modes

ill let you define the section plane by pressing/holding the trigger 

and moving the controller. The plane will align with the panel. Release the trigger in 

freeze the plane (See Figure 20). 

Define the plane by selecting a geometric face 

(press/release the right trigger). The plane will align with the selected geometry, and 

everything on the front-side of the face will be cut away. 

Define the plane by selecting a geometric face in the model (press/release 

rigger). The plane will align with the selected geometry, and everything on 

side of the face will be cut away. 
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Use up/down in order to select which setting to modify. 

Click left/right on the right controller to select three different modes for 

ill let you define the section plane by pressing/holding the trigger 

and moving the controller. The plane will align with the panel. Release the trigger in 

Define the plane by selecting a geometric face in the model 

. The plane will align with the selected geometry, and 

Define the plane by selecting a geometric face in the model (press/release 

rigger). The plane will align with the selected geometry, and everything on 



Third line: Plane offset – use left/right (click) in order offset the plane.

Fourth Line: Currently unused

Fifth line: When a plane has been defined, use left/right (click) in order to toggle the plane 

active/inactive. 

Sixth line: Use left/right (click) in order to reset (remove) the plane.

Figure 20: Define section plane using the controller. Press/release the trigger in order to make the section 

plane align with the panel on the controller.

13.1.11 Hide and show objects

 

With this tool you can select/deselect multiple 

controller. Use up/down on the touchpad 

Note: “Isolate selected” is currently NOT implemented.

Figure 21: Hide/unhide selected objects. 

middle-click to execute. 
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use left/right (click) in order offset the plane. 

Currently unused. 

When a plane has been defined, use left/right (click) in order to toggle the plane 

Use left/right (click) in order to reset (remove) the plane. 

Define section plane using the controller. Press/release the trigger in order to make the section 

plane align with the panel on the controller. 

Hide and show objects 

ol you can select/deselect multiple objects using the trigger on the right 

on the touchpad to choose what to do. Use middle

is currently NOT implemented. 

Hide/unhide selected objects. Use up/down click in order to navigate in the list of options
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When a plane has been defined, use left/right (click) in order to toggle the plane 

 
Define section plane using the controller. Press/release the trigger in order to make the section 

objects using the trigger on the right 

. Use middle-click to execute. 

 
list of options. Use 



13.1.12 Screenshots 

 

With this tool you can create a screenshot/snapshot of the current view. Press/release th

trigger on the right controller

will be saved in a screenshot-folder at the same location where your loaded model is stored. 

If you are doing this from the Revit addin, the screenshot will be s

Documents folder in a subfolder named BIMXplorer

 

 

 

13.2 Using the Oculus Rift 

Note: As BIMXplorer is not “signed” with Oculus it is required to tell Oculus to allow 

“Unknown Sources”. Start the Oculus so

Unknown Sources. 

If the Oculus is connected when BIMXplorer is 

plugin) it will automatically enter “Oculus mode”. 

settings) is functional as before but the navigation interface is different.

With the Oculus Touch controllers we are using the same general interaction interface as 

with the HTC Vive (See section XX.Y)

to the Vive interface. Middle

BIMXplorer v1.4.5 now has native support for Oculus Touch and you NO longer need to 

have SteamVR installed! 

Figure 22: Oculus Touch 
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With this tool you can create a screenshot/snapshot of the current view. Press/release th

trigger on the right controller to take a screenshot (the screen will blink once)

folder at the same location where your loaded model is stored. 

If you are doing this from the Revit addin, the screenshot will be saved in the current users 

Documents folder in a subfolder named BIMXplorer\screenshot. 

Oculus Rift with Oculus Touch: 

As BIMXplorer is not “signed” with Oculus it is required to tell Oculus to allow 

Start the Oculus software and go to Settings->General and enable 

If the Oculus is connected when BIMXplorer is started (either as standalone or as a Revit 

plugin) it will automatically enter “Oculus mode”. The menu system (i.e. file loading and 

functional as before but the navigation interface is different. 

With the Oculus Touch controllers we are using the same general interaction interface as 

ection XX.Y). See figure below for the mapping of buttons ac

Middle-click is executed by pressing/releasing the joystick.

BIMXplorer v1.4.5 now has native support for Oculus Touch and you NO longer need to 

Oculus Touch controllers button mapping and trigger. 
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With this tool you can create a screenshot/snapshot of the current view. Press/release the 

to take a screenshot (the screen will blink once). The image 

folder at the same location where your loaded model is stored. 

aved in the current users 

As BIMXplorer is not “signed” with Oculus it is required to tell Oculus to allow 

>General and enable 

alone or as a Revit 

The menu system (i.e. file loading and 

With the Oculus Touch controllers we are using the same general interaction interface as 

. See figure below for the mapping of buttons according 

click is executed by pressing/releasing the joystick. NOTE: 

BIMXplorer v1.4.5 now has native support for Oculus Touch and you NO longer need to 

 
 



13.3 Using the Oculus Rift 

Note: As BIMXplorer is not “signed” with Oculus it is required to tell Oculus to allow 

“Unknown Sources”. Start the Oculus so

Unknown Sources. 

If the Oculus is connected when BIMXplorer is 

plugin) it will automatically enter “Oculus mode”. 

settings) is functional as before but the navigation interface is different.

To control movement we are using the 

forward in the direction you look

increase/decrease the navigation s

on the keyboard to activate gravity and collision.

Settings (changing the “Eye height” parameter in BIMXplorer has no effect in “Oculus 

Mode”). To calibrate the Oculus eye height, go to 

View.  

Figure 23: The Oculus Rift navigation interface.
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Rift without Oculus Touch: 

As BIMXplorer is not “signed” with Oculus it is required to tell Oculus to allow 

Start the Oculus software and go to Settings->General and enable 

If the Oculus is connected when BIMXplorer is started (either as standalone or as a Revit 

plugin) it will automatically enter “Oculus mode”. The menu system (i.e. file loading and 

functional as before but the navigation interface is different. 

control movement we are using the Oculus Remote (Figure 23). ”

in the direction you look, and ”Down” backward. Right and Left will 

increase/decrease the navigation speed. If collision meshes are generated, you can press “

to activate gravity and collision. The “eye-height” is taken from the Oculus 

Settings (changing the “Eye height” parameter in BIMXplorer has no effect in “Oculus 

Oculus eye height, go to Settings->Devices->Sensor

 
: The Oculus Rift navigation interface. 
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As BIMXplorer is not “signed” with Oculus it is required to tell Oculus to allow 

>General and enable 

alone or as a Revit 

The menu system (i.e. file loading and 

”Up” will take you 

Right and Left will 

If collision meshes are generated, you can press “c” 

height” is taken from the Oculus 

Settings (changing the “Eye height” parameter in BIMXplorer has no effect in “Oculus 

>Sensor->Reset Default 


